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Introduction

Thank you for choosing this advanced PTZ camera system. The system is an integrated camera, optical
zoom lens and high-precision, 360° pan and tilt system.

This PTZ camera system is a rugged design for use in exposed outdoor locations around the world.

This manual provides information for the installer and user for the PTZ units with their associated control
boxes.

Product Features

This product is a highly flexible precision PTZ camera system that can be fitted with a range of high
resolution, high sensitivity day/night zoom camera modules. Features available vary with the camera
module selected.

The PTZ unit includes an advanced pan & tilt mechanism with brushless DC (BLDC) motors for rapid and
precise movement control with enhanced accuracy and reliability. The aluminium pressure die cast
housings, are highly durable and resistant to vandalism. A three-part coating system provides the
housings with outstanding resistance to corrosion and degradation by UV.

The PTZ unit is available with an optional LED illuminator having high intensity white light and infra-red
lighting. The LEDs are controlled in banks to provide the best lighting for the ambient conditions and the
camera zoom position.

The product is supplied, as standard, with up-the-coax and multiprotocol RS-485 telemetry. The complete
camera system is compatible with industry standard control equipment making it ideal for system
upgrades as well as new installations. Both IP and analogue versions are available.

A number of different control boxes can be supplied which provide power to the camera system and
allow access to a wide range of control and alarm functions.

Figure 1 GANZ Nautilus Camera Figure 2 GANZ Nautilus with LED illuminator
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Safety

A

THIS CAMERA SYSTEM MUST BE INSTALLED, OPERATED AND MAINTAINED IN ACCORDANCE WITH THE
MANUFACTURER’S INSTRUCTIONS.

1. Please study this Technical Manual thoroughly before installing, maintaining or using the camera
system.
2. Do not drop the PTZ camera unit.
3. The PTZ camera unit should only be connected, using the cable supplied, to an approved control box.
4. Ensure power is disconnected and locked off before installing or maintaining the system.
5. Installation of this system should be carried out by suitably trained and qualified technicians in
accordance with local electrical codes.
6.To prevent the risk of hazards such as fire or shock do not expose this camera to water before or
during installation.
7.Do not drop or shake the carton severely.
8. Do not touch the viewing window as this may result in a blurred picture.
9. Do not turn the camera to face strong light, this may cause blooming or smearing of the picture.
10. Do not install or use the camera in an environment of extreme temperatures. See Product
Specification Section of this Manual for limitations.
11. Do not disassemble any part of this system with the power on.
12. This camera system is not suitable for the following environments:
a. Explosive atmospheres
b. Life critical systems
c. Safety critical systems
13. The camera system should be installed where it cannot be tampered with by unauthorised personnel.
14. The camera system components should be securely fastened to a structure of sufficient strength to
support them. Allowance should be made for additional loads caused by local wind effects.
15. For PTZ units fitted with an illuminator DO NOT look at the lights when power is on — the lights are very
high brightness. NOTE: The infra-red lights are not visible to the naked eye.
16. PTZ units fitted with an illuminator should not be installed or used in such a way that the lights may
dazzle people, especially those driving vehicles.

AN

When shipping the camera by air it should only be carried in a pressurized hold as it is a sealed system.
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Contents Supplied

GANZ Nautilus

GANZ Nautilus with LED llluminator

PTZ Camera Unit

PTZ Camera Unit with LED llluminator

Safety Lanyard and fixings Safety Lanyard and fixings

Installation and set-up guide Installation and set-up guide

Cable assembly

Cable assembly (Options available)

Control Box

Control Box (Options available)

Brackets to mount control box Brackets to mount control box (Depending on box)

If parts appear to be missing or damaged this should be reported immediately to your supplier.

Lanyard

PTZ Camera Unit

Brackets for

Control Box
Control Box /
= =
] ]

Figure 3 Complete PTZ Camera System

Instructions for the Disposal of Electric and Electronic Equipment

The Wheelie Bin symbol on this product or its packaging indicates that the product is
required to be disposed of in an acceptable manner. This is in accordance with the
WEEE Directive 2002/96/EC. For more information regarding the correct disposal of this
unit at the end of its life please contact the company from which this unit was
purchased.

05/07/2016
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Product Specification

AN HOUSIMNG

TILT HOUSING

SUNSHIELDS

LaNYARD ASSEMBLY

MOUNTING FLANGE

Figure 4 PTZ Camera Unit

PTZ Camera Unit

Mechanical Features

The PTZ unit is supported by rolling element bearings from the mounting flange and is capable of 360° continuous
pan rotation. Movement is by a high precision BLDC motor with direct drive. The camera module and control
electronics are housed in the tilt housing.

The tilt housing is supported on rolling element bearings from the pan housing and is capable of 360° continuous
rotation. The image is flipped through 180° in software so that the viewer always sees a normally orientated image
on the screen. The tilt head is protected from solar heating by fixed sun shields.

A wiper is fitted that may be driven remotely to clear water from the viewing window of the camera.

A unit fitted with an LED illuminator available. It consists of a set of white and infra-red LEDs that are powered and
controlled from within the PTZ unit. The lights are controlled by complex algorithms to provide full illumination,
adjusted to the zoom distance of the camera. Manual selection of white or infra-red lighting is available via the
control box.
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Specification

Value

Ingress Protection

IP68 (To BS EN 60529)

Sealing Static seals — special o rings. Rotary — PTFE faced low friction seals.
Housing Construction Die-cast aluminium
Window Glass

Housing Finish

Three stage paint system. Finish, powder coat white to RAL9002.
Tested to EN60068-2-52.

Weight (with LED illuminator)

7.1kg

Weight (without illuminator)

6.8 kg

Dimensions

See Figure 6 & 7

Mounting flange

4 x 10mm bolt holes on 4” (102mm) PCD

Maximum operating temperature

60°C (Continuous)

Minimum operating temperature

-20°C Non-icing

Wind loading 100 mph (no damage), 70 mph fully controlled operation
Wiper Fitted as standard (integrated control)
Bearings Ball bearings for pan and tilt

Pan movement

360° continuous

Tilt movement

360° continuous

Housing impact resistance

Tested to EN62262 — IK10

Vibration resistance

Tested to EN60068-2-6

Shock resistance

Tested to EN60068-2-27

Electrical features

The PTZ Unit must be connected to an approved control box which provides connections for power and control.

Specification Value
Power Supply 48 volts d.c.
Input Power 10.8 Watts (nominal) unit with no lights

25.6 Watts unit with lights operating
141 Watts max. power with all auxiliaries and maximum load on
motors.

Surge Protection

Built-in with lightning protection

Controller Protocols

Note: Availability depends upon the camera module fitted.

Protocol Name
RS-485 Overview, BBV485, Pelco P, Pelco D, Samsung SCC-3000 , Sensormatic,
CBC C-Dome, Forward Vision MICI-300, VCL, Vicon.
Co-axial Pelco Coaxitron"", BBV UTC

IP

Available only on IP cameras. Uses ONVIF profile S.
Proprietary SDK available.

All of the above control protocols are available via the Control Boxes.

05/07/2016
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LED Illuminator (Optional fitting).

Specification Value
Power Supply Generated internally
White LED lights 3 off with wide angle lens

4 off with narrow angle lens
4 off with telephoto lens

Infra-Red (IR) LED Lights 3 off with wide angle lens
4 off with narrow angle lens
4 off with telephoto lens

Control Control is automatic to provide the best lighting depending on the
ambient conditions, the zoom position and the sensitivity of the
camera option fitted.

Manual control is available.

Heat sink Integral

Camera
The PTZ unit may be supplied with a range of different cameras which offer different features. Check
manufacturer’s label to ascertain which camera is fitted to your unit.

Both analogue and IP cameras may be supplied. In some cases, a built-in IP video encoder card is used to
provide an IP output.

See Appendix 4 for details of the cameras fitted to this product.

This is the property of CBC (Europe) GMBH, no copying without
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Menu System
The PTZ camera system may be set up and adjusted via a series of commands accessible via menus that appear
on a monitor screen connected to the video output from the control box. The on screen menu system offers a
simple, intuitive and powerful interface to a complete set of features, with password protection for increased
security.

Password protection: Built in

Languages supported: English, French, Spanish, German and Italian

Main Run H Muotion J

Eritar Sty Format Edit
: P -
Pasgword Setup }—‘[ Motion Pasition Pu_lgétnnn
S=tup
Tour Edit Tour
Camera White
| Video Satup Balance
— Joystick Advenced Endsbops
| P Privzcy
ey Satup
\ J
- Alarm Alarm
Alarms Satup Actian
. J
Alarm m
Mask Setug
Alarm
Alarm
oy [ e
Display | rS;mI:EE
Options Setug
Edn
|| De=mn
Fuosition
Text
Error
L
Date and
— Time
Sstup
|| Position
Cwemdas
|| Spedal Timeout
Settings Action
Emar
| oo )—| 22,
‘. Lighting '

Figure 5 On-screen Menu Structure Diagram
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See Appendix 2 - Control Menus for a page-by-page description of the menus.

Drive Capabilities

Specification

Value

Number of pre-sets

32 via menus, 250 total (user configurable)

Number of mimic tours

4*2 minutes (user configurable)

Number of pre-set tours

16 (user configurable)

Pre-set accuracy

0.05°

Pan range 360° continuous rotation. User configurable soft ends-stops.

Tilt range 360° continuous rotation with optional automatic image e-flip. User
configurable soft end-stops.

Pan speed 0.05°/s - 360°/s

Tilt speed 0.05°/s - 360°/s

Power fail Configurable last action restoration on power up

Software upgrades

Fully upgradable over RS-485 link both prior to and post installation.

Joystick control

Variable selectable speed ranges for precision control. Variable speed
adjustment with zoom depth.

Video System

Specification

Value

Privacy zones

12 (8 positions per screen. Solid or mosaic)

Video effects

Freeze frame

Video format

PAL / NTSC (model dependent)

Scanning system

2:1 interlace

Image sensor

%” interline transfer CCD

Optical zoom speed

~2.1s (wide —telephoto) typical, camera module dependent.

Digital zoom speed

~1.7s typical, camera module dependent.

Iris control

Automatic with manual override (16 steps)

Focus Automatic with manual override

White balance Automatic with manual override

Gain Automatic

IR filter Automatic with manual override

Video output Variable 1Vp-p to 2Vp-p, 75 ohms (8 steps)
Video lift 8 steps

05/07/2016
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Control Box

A number of optional control boxes are available: The Intelligent Junction Box and the Standard Junction Box can

be specified at point of order. They offer differing levels of protection and control features which are shown

below:

Mechanical Features

GANZ Nautilus Technical Manual

Version 1.0

Specification

Value

Product

Intelligent Junction Box

Standard Junction Box

Ingress Protection

IP65 (To BS EN 60529)

IP65 (To BS EN 60529)

Box Construction Steel with removable hinges ABS

Box Finish Paint Self-Colour
Weight 8.4 kg 3.4 kg
Dimensions See figure 7 See figure 9
Mounting 4 Brackets 4 Brackets
Maximum operating 65°C (Continuous) 65°C (Continuous)
temperature

Minimum operating -20°C Non-icing -20°C Non-icing
temperature

Housing impact resistance

Tested to EN62262 — IK10

Tested to EN62262 — IKO8

Electrical features

Specification

Value

Product Intelligent Junction Box Standard Junction Box
Power Input 100 to 277 volts, 50 or 60Hz 100 to 277 volts, 50 or 60Hz
Power Output 48 v dc+/- 3% 48 v dc+/- 3%

Fuses 10 Amp 10 Amp

Input Power 250 W Nominal 130 W Nominal

Surge Protection

Built-in with limited lightning protection

Built-in with limited lightning protection

EMC

BS EN 55022

BS EN 55022

Washer motor control

Single Pole Changeover Rated 240V /
1Amp

Auxiliary Relay

Single pole changeover rated 240V /
1 Amp

Tamper switch

Operated by opening lid

User Digital Inputs

8 volt-free contacts (External)

Washer Test Button

Internal switch for pump priming

Reset button

Internal switch for commissioning and
re-programming.

05/07/2016
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Installation Drawings:
Camera PTZ Unit

357

243.8
(TILT CENTRE]

56.5

105
(MOUNTING CENTR
O

E

WINDOW CEMTRE]

[rax SWING FROM CEMNTRE]

184

MOUNTING HOLES
dx @ 10 THROUGH

265

ELECTRICAL CONMECTOR
18 WAY CHOGOR| TO SUIT
ABLE SUPPLIED]

Dimen

sions in mm

Figure 6 Installation Diagram for GANZ Nautilus PTZ Unit
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263.5
(TILT CENTRE]

565

752

194 [SWING]

Dimensions in mm

Figure 7 Installation Diagram for GANZ Nautilus PTZ Unit with LED Illuminator
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Control Boxes

GANZ Nautilus Technical Manual Version 1.0

1. Intelligent Junction Box

KOTE + WALL HOUNTING BRACKETS
SUFFLIED LOOSE

Figure 8 Installation Diagram - Intelligent Junction Box

Cable glands should be at the bottom.
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2. Standard Junction Box

& 7.6,

O
]
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Figure 10 Standard Junction Box Installation Drawing
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Installation / Connection

JAN

Warning: Take care when working at heights. Ensure safe working practices are followed to prevent danger to the
installer or those below.

Electrical Installation must be carried out by a suitable trained and qualified technician.

Note: Choose the position for installation carefully to avoid the likelihood of lightning strikes as these will damage
the camera.

Camera systems should not be installed in a position where they invade privacy.

Care should be taken to ensure that camera systems with LED illuminators do not cause annoyance or danger, e.g.
by dazzling drivers.

Installation — Mechanical

PTZ Camera Unit

Warning: The PTZ Unit is a sealed unit containing no user serviceable parts. The housing should not be
dismantled by the user. Return to the supplier for rectification of any faults.

The PTZ unit may be installed with the base at the bottom e.g. on a specially designed pole. It may also be
mounted with the base at the top, e.g. suspended from a suitable bracket. The camera must NOT be installed with
the axis of the pan arm in the horizontal plane.

Figure 12 Allowable Mounting Positions for PTZ Unit

A variety of mounting accessories are available: See Accessory Table in Appendix 3.

The following points must be observed:

1. Power must not be connected to the PTZ unit until it is securely fixed to the point of installation.

2. Alug should be provided at the mounting point to which the maintenance lanyard can be attached during
installation. See Figure 13 & 14.

3. Sufficient space should be allowed around the camera so that it is free to rotate through its full movement
in all directions. See figure 15.

4. Provision should be made in the mounting point to route the cable away from the base of the camera.
using conduit or by routing through a protected route, such as the inside of a mounting pole.

5. Cables are available in various lengths: See accessory Table in Appendix 3.

6. The camera should be offered up to the pre-drilled mounting point and the lanyard attached to the lug
provided.

7. The cable should be attached to the connector in the base of the camera, taking care to orientate
correctly and the connector locking nut should be tightened by hand.
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8. The cable should be routed from the PTZ unit to the control box, being supported and protected between

GANZ Nautilus Technical Manual

both throughout its length.

9. The camera base should be bolted to the installation point using M8 screws of a suitable length with nuts
and plain washers. Self-locking nuts are recommended. Care should be taken not to damage the paint

during installation as this will cause corrosion of the housings.

10. When the camera is installed and before power is connected, rotate the camera slowly by hand to ensure

that it is free to move in all directions.
11. Check security of all fixings.

Version 1.0

Electrical connector

Lanyard Clip "
Figure 13 Position of electrical connector in base of PTZ Unit
Lug for Lanyard Clip
Figure 14 Typical Bracket Flange with Lug for Lanyard Clip
— BC(E B - -
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Figure 15 PTZ Unit showing space required for movement (Unit with LED Illuminator on the Left)

Control Box

The control box should be securely fixed to a vertical surface with sufficient space around it to access the cover
and make connections to the box.

Control boxes should always be fixed with the cable glands at the bottom.

Brackets are supplied for fixing the Intelligent Junction box. These must be used for fixing — no fixing holes should
be drilled in the box.

The Standard Junction Box has through fixing holes in the box. No fixing holes should be drilled in the box.

Boxes must be securely fixed.

Figure 16 Intelligent Junction Box and Standard Junction Box (Right)
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Installation Electrical

A\

Electrical installation should be made by a suitably qualified electrician and all wiring should meet local and
national regulations.

The PTZ Camera Unit should be connected to the Control Box using the cable supplied. The connections should be
made to the terminals in the control box, using the colour coding on the leads as shown in Figure 17 or 18

The mains electrical supply should be connected to the terminals shown in Figures 9 and 11. The supply should be

fed from a suitably protected isolating device. The earth terminal should be connected to the supply earth.
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Z2 o Z o
xlxlx'xl
l:Elc:l.”l"vl
i g~
=2 2 2 2
EEEE .
T T £ X =
Z a Z o W to W i b =
N: o ﬁ: '_4: él él ?él §| 2 < = gll
S EgBEggggisis = 28
$§%%z333 5522222883583 222
T 1 ] 1 | |
1
|| I | | | ETHERNET
2o B EEES SEEEEEEEREEYE
E¥zZIzis ZiTzxzgiFEzo
= 522z & £®72>=2 z0:%¢g
[=1 3 = Fr 5 uf = =
$8E= % g & 2 e 3 ANALOG VIDEO g
% %U = 2 5 E OUTPUT

HYDRA CABLE

Figure 18 Connections from Control box to PTZ Unit - Standard Junction Box

Alarm Inputs

The Intelligent Junction Box is fitted with 8 input channels that can be connected to volt-free alarm contacts. The
function of each input can be programmed by the user through built-in software commands. Screw terminals are
provided in the box to give access to these inputs. See Figure 17 & 19
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Figure 19 Alarm Trminals in Intelligent Junction Box

Auxiliary Relay

A single pole changeover relay rated at 240VAC / 1 Amp (24VDC) is fitted to the Intelligent Junction Box. This may

be programmed to provide an electrical output to the user’s system. Screw terminals are provided in the box to
give access to these connections. See Figure 9 & 20.

Washer Relay

A single pole changeover relay rated at 240VAC / 1 Amp (24VDC) is fitted to the Intelligent Junction Box. This may

be programmed to drive a washer pump motor. Screw terminals are provided in the box to give access to these
connections. See Figure 9 & 20.

Figure 20 Washer Relay and Aux. Relay in Intelligent Junction Box

Video Ground Link

A video ground link is provided so that the video signal ground can be connected to earth (or not) as required. See
Figures 9 & 11
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JAN

NOTE: The use of a UPS to supply the Control Box:

To Comply with EN50130-4 Alarm Standard — CCTV for Security Applications it is necessary to provide an ancillary
uninterruptable power (UPS) supply. The UPS must have a Transfer Time between 2—6 ms and a Backup Runtime
of greater than 5 seconds for the power level specified in this manual.

Commissioning and Set-Up

YN

No o k~w

10.
11.

12.
13.
14.

Warning: Safe working practices must be followed when working with electricity or at heights.

Ensure all protective covers are in place to prevent accidental contact with live parts especially where the
mains electricity enters the control panel.

Any adjustments inside the control panel should be carried out by suitably qualified and trained electrical
technicians.

Keep personnel and tools away from the PTZ unit as it may move unexpectedly during set-up.

Avoid contact with the LED Illuminator unit as it may become hot to touch after prolonged use.

Check that that the switch settings in the control box are correct for the desired configuration.

Ensure all wiring is complete and secured.

Switch power on to the control box and observe the PTZ unit go through its calibration routine. Depending
on which camera module is fitted, this may take 2 — 3 minutes.

From the control console the camera should be operated manually to ensure that it rotates freely in all
directions in response to commands. Camera zoom and focussing should be confirmed by viewing the
image on a monitor.

If a washer pump is fitted, this may be primed using the manual over-ride in the control box.

The operation of the wiper should be confirmed.

Where an LED illuminator system is fitted it should be tested after ensuring that no one is looking at the
lights.

By referring to Appendices 1 and 2 the camera system can be set up according to the user’s specification.
When set, the alarm inputs and operation of the auxiliary relay may be checked.

On completion of commissioning ensure that all electrical enclosures are closed and locked and that the
Manual is made available to the User.

Maintenance

A\

Warning: Safe working practices must be followed when working with electricity or at heights.

The PTZ unit and its control box do not require any routine maintenance.

Best performance will be maintained if the viewing window and exterior surfaces of the camera are cleaned from
time to time.

Before cleaning, power to the PTZ Unit should be turned off. Cleaning should be done using water and household
detergents. No solvents should be used.

It is good practice to check every 6 months to ensure that all fasteners are tight, all cable glands secure and that
conduits for cables have not been damaged.

The wiper blade should be checked for damage and where used, the washer reservoir should be topped-up.
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Firmware updates
Firmware can by updated over RS485 by using the Update application (shown in Figure 21) running on a PC which
uses a USB / COM port — RS485 converter to access the control box RS485 bus.

1)
2)
3)

4)
5)

7)

[ ESEE S
File Options Help
Application
File: ||
Range | Entry: LRC:
Version;

Icom11 115200 PBL Version: -

Device |nformation:
‘ J

Status

Figure 21 - Firmware update application

Using File->Open, browse to the desired firmware file (.mot)

Select the correct COM port using Options->COM Port

Select the highest supported baud rate using Options-> COM Speed. 115200 is recommended. This is the
baud rate of communication between the PC and the bootloader and is independent of any control box
protocol setting.

Begin the upgrade process by pressing “download”.

A dialog box will pop up requesting that the system is power cycled. Power cycle the system and then
click “Ok”.

The new firmware will be downloaded to the control box. When the download is complete, begin the
firmware upgrade by selecting File -> JunctionBox Reprogram.

The system will need power cycling a second time, and then the upgrade will begin. The system will restart
automatically when the upgrade is complete.
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Appendix 1. Address Switches Settings and Controller Protocols

Inside the control box there are a number of address switches that can be programmed to provide various
features.
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Figure 22 Address Switches in Intelligent Junction Box

The switch statuses are read by the control box processor on power up. If the state of a switch is changed, the
system will have to be power cycled for the change to be detected.

Switch S3 — Unit Address
Bits S3[8:1] are used to set the unit address for RS485 communications from 0-255. Bit S3-1 is Isb. Note that some
protocols are O-indexed but most are 1-indexed.

Switch S1 — Protocol, Unit Orientation and RS485 Termination
Bits S1[5:1] are used to set the RS485 protocol according to Table 1.

Protocol Baud rate (bps) | S1[5] | S1[4] | S1[3] | S1[2] | S1[1]
Overview/Pelco P/Pelco D autodetect | 9600 0 0 0 0 0
Overview/Dennard 9600 0 0 0 0 1
Pelco P 9600 0 0 0 1 0
Pelco P 4800 0 0 0 1 1
Sensormatic 4800 0 0 1 1 1
Samsung SCC-3000 9600 0 1 0 0 1
Pelco D 2400 0 1 0 1 1
CBC C-Dome 9600 0 1 1 0 1
Forward Vision MIC-300 9600 0 1 1 1 0
VCL 9600 1 0 0 0 1
BBV 485 9600 1 0 0 1 0
Vicon 4800 1 0 1 0 0
Pelco D 9600 1 0 1 0 1

Table 1 - RS485 protocol switch S1 setting

Bit S1[6] is used to change between which coaxial protocol can be used in parallel to the RS485 protocol. S1[6] =
OFF is Baxall/BBV UTC. S1[6] = ON is Pelco Coaxitron™.
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Bit S1[7] is used to inform the system of the orientation of the PTZ unit in order to provide correct compass
functionality. S1[7] = OFF is “upright” orientation as seen on the left of Figure 12. S1[7] = ON is “hanging”
orientation as shown in the middle of Figure 12.

Bit S1[8] is used to select on-board RS485 termination in the junction box. S1[8] = ON connects a 120Q) resistor
between the RS485 A and B lines.

Switch S6 — Relay and Washer enable
Bit S6[1] controls whether the auxiliary relay is enabled. ON = enabled.

Bit S6[2] sets the source of the auxiliary relay control if the relay is enabled by S5[1]. S5[2] = OFF sets the control to
the PTZ camera unit. This will allow the relay to be controlled via setting an alarm action or RS485 message etc.
S5[2] = ON sets the control to locally in the junction box. This ties the auxiliary relay status to the status of alarm
input 1, so the relay will change when the alarm status changes.

Bit S6[3] controls the relay actuation mode.

e S6[3] = OFF is a “1 second toggle”. For example, if S5[2] is set to PTZ camera unit control (OFF) and an
alarm action has been set to action the relay, when the alarm is raised the relay will change state, and
then change state back after a 1 second delay. The relay will not change status when the alarm is de-
raised. Similarly, if S5[2] is set to junction box control (ON), the relay will change then change back after a
1 second delay only when alarm 1 input is raised, not when it is de-raised.

e S6[3] = ON is “latch”. If S5[2] is set to PTZ camera unit control (OFF), the relay status will change when an
alarm is raised, and will maintain the change of status until the alarm is de-raised via rs485 message. If
S5[2] is set to junction box control (ON), the relay will change when the alarm 1 input is raised and will
maintain status until the alarm 1 input is de-raised.

Bit S6[4] enables the washer relay. A wash routine can be triggered by setting a “wash” position override using the
menus. See the Position Override section of the menu description for more details of the wash routine.

Bit S6[5] is to provide future support for tamper switch alarm functionality. It is not currently supported in
firmware.

Bits S6[8:6] are unused.

Switch S4 — Alarm enable

S4 is used to enable each alarm input to the junction box. Each bit of S4 corresponds to the same alarm input
number. When an alarm input is enabled, a change of state as set by the polarity setting for the alarm (see switch
S5) will cause the alarm to be raised with the PTZ camera unit, and any corresponding alarm action to be taken.

Switch S5 — Alarm polarity

S5 is used to set the polarity of each alarm. Each bit of S5 corresponds to the same alarm input number. When the
switch is set to OFF, the alarm is set to normally closed (NC) contacts. This will cause an alarm to be raised if the
alarm connections go open circuit. If the switch is set to ON, the alarm is set to normally open (NO) contacts. In
this setting, the alarm will be raised if the alarm contacts go short circuit.

This is the property of CBC (Europe) GMBH, no copying without

05/07/2016 .
permission

30




CBC (EUROPE) GMBH GANZ Nautilus Technical Manual Version 1.0

Appendix 2 - Control Menus

Menu Structure

Introduction
This product uses a straightforward, simple, intuitive conventional menu structure which features:

e Multiple languages: the menu can be displayed in English, French, Spanish, German or Italian

e Simple, intuitive menus

e Minimised menu pages and key entry for actions

e Alpha-numeric password protection

e 32 pre-set positions, 16 pre-set tours, 4 one-minute joystick mimic tours, all of which are easy to set
up from one menu screen

e Simple position title insertion

e Comprehensive general features

e Video gain and lift micro adjust

e Real time clock
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Figure 23 Menu Structure
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Menu Page-by-page guide — Notes

needed

The user can navigate
between selectable
menu items by sending
Up/Down/Laft/Right
Joystick commands 2s

*h-—--

Sending a “set” command
while the back arrow is
selected returns to the
parent menu page. From
the main menu, the back
Brrow exits the menu.

PASSWORD

ABCOEFGHIJKLMNOPARSTUVHX
YZabcdefghiiklmnoparstuv
wxyz01234567R9

Version 1.0

On menu pages where the user can input text by selecting digits from
the keyboard grid, the beckwards triangle can be used to delete the
previous digit.

The forward: triangle confirms the input and moves to the next page.

Figure 24- Explanation of standard menu controls

Menu Control Commands

By default, “go to pre-set 2” is set up as a position override to open the menus. If this functionality is not required,
for example because the RS485 protocol in use supports an “open menu” command, position overrides can be

changed or disabled in the position override menu.

GO TO PRESET 1 acts as select once in the menus. In addition to this, some protocols offer additional menu/select

functionality:

Protocol

Enter/Exit menu

Select in menu

Pelco P

STORE PRESET 95

Samsung SCC-3000 0OSD AF
Pelco D STORE PRESET 95
Forward Vision 300 F3 F4

Pelco Coaxitron™

GO TO/STORE PRESET 95

GO TO PRESET 1/OPEN IRIS

BBV UTC

#+1

1

Table 3 Menu control commands for included control protocols

Once in the menus, the Position Override menu can be used to customize actions for GO TO PRESET 2-99

05/07/2016
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Menu Page-by-page guide
Main Menu

RUN
SETUP

Figure 25 - Main menu page

The main menu page is the first page which is entered when an “enter menu” command or pre-set override is
received. It allows access to the Run and Setup menus. To move to another menu page, send Up/Down/Left/Right
joystick commands as required until the desired option is flashing, then send a set/select/go to pre-set 1
command. To exit the menus and resume normal joystick control, select the back arrow.

Run Menu

MOTION
WIPER

Figure 26- Run menu page

e The Run menu provides access to the Motion menu, and also provides wiper control.
e To start wiping, select WIPE. To stop wiping, select WIPE again.
e The back arrow returns to the main menu
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Motion Menu

POSITION

s du o Ric 7 8
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1fig ciele PP 23 214
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8 10
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‘-

Figure 27 - Motion menu page
The motion menu provides any user access to pre-set positions and tours.

e To goto a pre-set position from 1-32, select the corresponding position number.
e Tostart a pre-set tour 1-16, select the corresponding tour number.

e To start a mimic tour M1-M4, select the corresponding tour number.

e The back arrow returns to the Run menu.

If a position or tour has not been set, a POSITION/TOUR NOT SET message will be briefly displayed when the
number is selected, and the menu will remain in place. If the position or tour has been set, then when selected the
menu will exit and the PTZ unit will begin moving to the chosen position or start the chosen tour.

Enter Password Screen

PASSWORD

ABCDEFGHIJKLMNOPGRSTUVUWX
YZabcdefghiiklmnoparstuv
wxyz0123456789

k===

Figure 28 - Enter password page
To access the setup menu from the main menu, the user must enter a password.

e To submit a password of fewer than 6 characters, select the forwards triangle.
e To erase a character, select the backwards triangle.

e A password is automatically submitted when the 6 character is selected.

e The back arrow returns to the Main menu.

e The default password is AAAAAA. This can be changed in from the Setup menu.
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Setup Menu

MOTION
VIDED
JOYSTICK
PRIVACY
ALARMS

DISPLAY OPTIONS
SPECIAL SETTINGS
CHANGE PASSUWORD

+

Figure 29- the Setup menu page

MOTION
VIDEO
JOYSTICK
PRIVACY
ALARMS

DISPLAY OPTIONS
SPECIAL SETTINGS
CHANGE PASSUWORD
LIGHTING

(-

Figure 30 - Setup menu page for an LED lighting unit
The Setup menu provides access to various submenus. Select a submenu to change to that menu page.

e The back arrow returns to the Main menu.
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Setup Motion Menu

FORMAT POSITION
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Figure 31- Setup Motion Page

The Setup Motion Menu is accessed from the Setup menu and allows the user to store, go to or delete positions,
or edit position text. Tours can also be stored, started or deleted.

e To set up a pre-set position, select the appropriate position number from 1-32.
e Toset up a tour, select the appropriate tour number.
e The back arrow returns to the Setup menu.

Format Position Menu

POSITION 1 - SET

STORE POSITION
GOTO POSITION
EDIT POSITION TEXT

DELETE POSITION

Figure 32 - Format Position menu page

When a position is selected in the Setup Motion menu, the Format Position menu page opens, and displays the
selected position number and whether the position is currently set or not set.

e To store a position, select STORE POSITION. The menu will remain on screen but PTZ control will now be
active allowing the user to change the PTZ unit position. When a set/select command is sent, the pre-set
will be stored as the current position, and PTZ control will cease and menu navigation will resume.

e To go to a position, select GOTO POSITION. The menu will exit and the PTZ unit will move to the stored
position. If the position is not stored, a POSITION NOT STORED message will be briefly displayed.

e “Position text”, which is displayed when the unit is at the position, can be set using the EDIT POSITION
TEXT option. This opens up the Edit Position Text menu page.

e The pre-set position can be deleted by selecting the DELETE POSITION option.

e The back arrow returns to the Setup Motion menu.
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Edit Position Text Menu

POSITION 1 TEXT

ABCDEFGHIJKLMNOPRRSTUVUX
YZabcdefghijklmnoparstuv
wxyz0123456789_

Figure 33- Edit position text menu

The Edit Position Text menu is accessed from the Format Position menu. The keyboard can be used to enter text
to be displayed when the unit is at the set position.

e To submit position text, select the forwards triangle.
e To erase a character, select the backwards triangle.
e The back arrow returns to the Format Position menu.

Set-Up Tour Menu

TOUR 1

EDIT TOUR
START TOUR
DELETE TOUR

Figure 34- Setup Tour menu page

Selecting a tour number from the Setup Motion page opens the Setup Tour page for the appropriate tour number.
The tour number and a set/not set status are displayed.

e For a pre-set tour, the EDIT TOUR option opens up the Edit Tour submenu. For a mimic tour, the RECORD
NEW MIMIC TOUR option is displayed instead, and selecting it will temporarily exit the menus and restore
joystick control while the new mimic tour is recorded.

e The setup tour menu also provides the option to start or delete previously stored tours.

e The back arrow returns to the Setup Motion menu.
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Edit Tour Menu

T1 POSITIONS
POS DWELL SPEED
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Figure 35- Edit Tour menu page
The Edit Tour page is accessed from the Setup Tour menu and is used to setup or change a pre-set tour.

e Up to 8 pre-set positions are supported for a tour created through the menus. Each row can have a pre-set
position from 1-32 selected, or be left blank. Any blank positions are not included in the tour, so a tour can
have fewer than 8 positions if desired. The forwards and backwards triangles are used to change pre-set
number.

e For each position, a dwell time can be set in seconds. This is the time the PTZ unit will pause at the
position.

e For each position, a “speed” can also be set. This is the time in seconds it will take the PTZ unit to move to
the next position in the tour.

e The back arrow returns to the Setup tour menu page.
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Video Menu

PICTURE MODE COL/MON
SHUTTER SPEED AUTO
DIGITAL ZO0OM OFF
FREEZE FRAME OFF
VIDEO GAIN <« 28 »
VIDEO LIFT <« 110 »

CAMERA SETUP

&

Figure 36 - Video menu page

The video menu is accessed from the Setup menu and provides various settings as well as access to the Camera
Setup submenu.

e Sending a “select” command while the Picture Mode setting is flashing will cycle between settings of
COLOUR, MONO and COL/MON as supported by the camera module. Default is COL/MON where the
camera will change between Colour and Mono modes automatically as determined by the scene
illumination.

e Available shutter speed options are: Auto, 1/10000, 1/3500, 1/1000, 1/215, Normal. Default is Auto.

e Digital zoom and be turned ON or OFF. Default is OFF.

e Freeze frame can be turned ON or OFF. When ON the video output will freeze while the PTZ unit is moving
between pre-set positions in a pre-set tour. Default is OFF.

e The forwards/backwards triangles can be used to set the Video gain from 0-254 in steps of 2. Default is 28.

e The forwards/backwards triangles can be used to set the Video lift from 0-254 in steps of 2. Default is 110.

e The Camera Setup submenu can be accessed by sending a Select command while the CAMERA SETUP
option is flashing.

e The back arrow returns to the Setup menu.
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Camera Setup Menu

ICR THRESHOLD
NEAR FOCUS
POSITION FOCUS
AUTO FOCUS
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Figure 37- Camera Setup menu page (SD)
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Figure 38- Camera Setup menu page (HD)

The Camera Setup menu is accessed from the Video menu and provides various camera settings and access to the
White Balance submenu. Each camera setting can be changed by sending a “select” command while the relevant
option is flashing.

e ICR THRESHOLD can be set from 5dB-25dB in 5dB chunks. Default 10dB.

e A NEAR FOCUS function can be turned ON or OFF. When ON, the internal camera limit that prevents
focussing on a target within 0.3m is disabled, so the camera can focus on something right in front of it.
When OFF, the camera is prevented from focussing on objects too near, which is intended to prevent
mounting points etc. from dominating autofocus. Default is OFF.

e The POSITION FOCUS setting can be either AUTO or MANUAL. In AUTO mode, the camera autofocus will
remain on when the PTZ unit is at a pre-set position. In MANUAL mode, at a pre-set position the autofocus
will be disabled and the focus value will be set to the focus value that was recorded when the pre-set
position was saved. Default AUTO.

e The AUTOFOCUS setting can be set to AUTO, ONESHOT or MANUAL. In AUTO mode, the camera autofocus
is turned on at all times. In ONESHOT mode, the camera makes a one-off attempt to autofocus whenever
it stops moving (whether it is after a joystick stop command, after it arrives at a pre-set position, or as part
of a pre-set tour). When moving, the autofocus is off. In MANUAL mode, the autofocus is off at all times
and the focus must be controlled by the user. Default AUTO.

e The Back Light Compensation (BLC) can be turned ON or OFF. Default OFF.
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e Wide Dynamic Range (WDR) mode is module dependent. For an SD unit it can be: ON, OFF, AUTO, F (Fixed
exposure ratio), D (Compatibility mode), or VE (Visual Enhancement), as supported by the camera module.
Default OFF. For an HD unit it can any value from 0-10. Default 0.

e Digital STABILIZATION mode can be turned ON or OFF. Default OFF.

e DEFOG mode is module dependent. For an SD unit it can be turned ON or OFF. Default OFF. For an HD unit
it can any value from 0-10. Default 0.

e The White Balance submenu can be accessed by sending a “select” command while the WHITE BALANCE
MENU option is flashing.

e The back arrow returns to the Camera Setup menu.

White Balance Menu

WHITE BALANCE
MAN WB RED
MAN WB BLUE

Figure 39 - White Balance menu page

The White Balance menu is accessed from the Camera Setup menu and provides control over the camera white
balance setting.

e The WHITE BALANCE mode can be set to: Auto White Balance (AWB), Auto Tracking White Balance (ATW),
INDOOR, OUTDOOR and MANUAL. Default AWB.

e |If WHITE BALANCE mode is MANUAL, the Red and Blue gains can be set from 0-15 by using the forward
and backward triangles.

e The back arrow returns to the Camera Setup menu.
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Joystick Menu

Z00M DIVIDE BY ON
LINEAR SPEED 5]

Z00M SPEED NORMAL
PAN DIRECTION NORMAL
TILT DIRECTION NORMAL

Ls/R CURSOR NORMAL
UsD CURSOR NORMAL

ADVANCED OPTIONS

&

Figure 40- Joystick menu page

The Joystick menu is accessed from the Setup menu. It provides control over various joystick settings, and access
to the Advanced Joystick submenu.

The ZOOM DIVIDE BY setting, when ON, automatically scales the joystick speed in inverse proportion to
the current zoom setting, to allow for finer positional control at high zoom levels. Possible settings are ON
or OFF. Default OFF.

LINEAR SPEED can be set from 1-8 and is a joystick speed scaling factor where the pan and tilt movement
of the PTZ unit will be fastest at 8 and slowest at 1. Default 5.

ZOOM SPEED controls the speed that the camera changes between wide to tele zoom levels. Options are
SLOW, NORMAL and FAST. Default NORMAL.

PAN DIRECTION controls whether the pan movement of the PTZ unit is reversed compared to left/right
joystick direction. Possible settings are NORMAL or REVERSE. Default NORMAL.

TILT DIRECTION controls whether the tilt movement of the PTZ unit is reversed compared to up/down
joystick direction. Possible settings are NORMAL or REVERSE. Default NORMAL.

L/R CURSOR controls whether the movement of the cursor in the menus is reversed compared to left/right
joystick direction. Possible settings are NORMAL or REVERSE. Default NORMAL.

U/D CURSOR controls whether the movement of the cursor in the menus is reversed compared to
up/down joystick direction. Possible settings are NORMAL or REVERSE. Default NORMAL.

The Advanced joystick submenu can be accessed by sending a “Select” command when the ADVANCED
OPTIONS setting is flashing.

The back arrow returns to the Setup menu.
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Advanced Joystick menu

SET NORTH POSITION
COMPASS MODE - OFF
FLIP MODE Sl EalEISTP
CONFIGURE ENDSTOPS

Figure 41- Advanced Joystick menu page

The Advanced Joystick menu is accessed from the Joystick menu. It provides control over compass display settings
and the electronic flip mode, as well as providing access to the Configure Endstops submenu.

e The unit can display its current compass bearing. In order to set the 0 bearing or “North” position, send a
select command when the SET NORTH POSITION option is flashing, while the camera is facing North.

e The COMPASS MODE can be set to OFF, CARDINAL, or DEGREES. Default OFF.

e FLIP MODE can be set to OFF or E-FLIP. In E-FLIP mode the video will invert when the tilt motor passes
through vertical, so that the video is always the correct orientation. When flip mode is OFF, the video will
not be inverted. Default E-FLIP.

e The Configure Endstops submenu can be accessed by sending a “Select” command when the CONFIGURE
ENDSTOPS setting is flashing.

e The back arrow returns to the Joystick menu.

Configure Endstops menu

ENDSTOP MODE - OFF
SET ENDSTOPS
RESET ENDSTOPS

Figure 42 - Configure Endstops menu page

The Configure Endstops menu is accessed from the Advanced Joystick menu. It provides control over the PTZ unit
soft endstop settings. Mechanically, the PTZ unit can rotate continuously in both pan and tilt, but can be limited in
software in either axis if desired.

e ENDSTOP MODE can be set to OFF (continuous on both axes), PAN (only pan axis is limited), TILT (only tilt
axis is limited) or BOTH (both axes are limited).
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e SET ENDSTOPS is used to set the beginning and end of the limited rotation region. The menu will remain
on screen but PTZ control of the unit will now be active allowing the user to change the position. When a
set/select command is sent, the first pan and tilt endstop is set as the current position, then PTZ control
resumes to allow the second pan and tilt endstop to be set, and then PTZ control will cease and menu
navigation will resume. Both pan and tilt endstops are set together regardless of the current endstop
mode. No previously set endstops are active while setting new endstops.

e RESET ENDSTOPS will restore the default endstop position and mode.

e The back arrow returns to the Advanced Joystick menu.

Privacy menu

SELECT PRIVACY ZONE

1 2 S 3emdaESuEE 7 8
9. 10 1112813014 15 16
17 18 13°20s2]152¢2 23 24

Figure 43- Privacy menu page

The Privacy menu is accessed from the Setup menu and provides access to the Privacy Setup menu for each
available privacy patch.

e Selecting a patch number will open the Privacy Setup menu for that patch.
e The back arrow returns to the Setup menu.

Privacy Setup menu

PRIVACY ZONE 1 - NOT SET

SET PRIVACY ZONE
GOTO ZONE
DELETE ZONE

DELETE ALL ZONES
MOSAIC PATCH S U

Figure 44 - Privacy Setup menu page

The Privacy Setup menu for each privacy patch is accessed from the Privacy menu. The selected patch number and
a set/not set status are displayed at the top of the menu.

e The selected privacy patch can be set by sending a “select” command while SET PRIVACY ZONE is flashing.
Joystick pan/tilt/zoom control will then become active until a second “select” command is sent. This
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allows the user to position the PTZ unit in the desired position before setting the patch to cover that
position. Menu control will resume when the second “select” command is received and the patch will
appear.

e If a patch has already been set, selecting GOTO ZONE will move the PTZ unit to the patch pan/tilt/zoom
location and the menu will exit.

o DELETE ZONE deletes the selected privacy patch.

e DELETE ALL ZONES deletes all privacy patches, not just the patch number that this instance of the Privacy
Setup menu controls.

e When a patch has been set, it can be changed from solid black to a mosaic effect by changing the MOSAIC
PATCH option from OFF to ON. Default is OFF.

e The back arrow returns to the Privacy menu.

Alarms menu

SELECT ALARM

1. s e 3o S | 7
g 10 Sl ele el el 4
1 1819 20ERINod cd
£5 26 2¢ 28 29 30

ALARM MASKS

I 29 4 onbqig8 9
ALARM HOLIDAYS

1' 2 3 4 567888
‘-

Figure 45- Alarms menu page

The Alarms menu is access from the Setup menu and provides access to the Alarm Setup, Alarm Mask and Alarm
Holiday submenus.

e To access the Alarm Setup submenu for a given alarm number, send a “select” command while the desired
alarm number from 1-32 is flashing.

e To access the Alarm Masks submenu for a given alarm mask number, send a “select” command while the
desired alarm mask number from 1-10 is flashing.

e To access the Alarm Holidays submenu for a given alarm holiday number, send a “select” command while
the desired alarm holiday number from 1-10 is flashing.

e The back arrow returns to the setup menu.
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Alarm Setup menu

ALARM 1 =SNail - SET

SELECT NEW ALARM ACTION
DELETE ALARM ACTION

Figure 46- Alarm Setup menu page

The Alarm Setup menu for each alarm is access from the Alarms menu. It provides access to the Alarm Action
submenu and the ability to delete an alarm action. At the top of the menu the selected alarm number and a
set/not set action status is displayed.

e To open the Alarm Action submenu for the selected Alarm, send a “select” command while SELECT NEW
ALARM ACTION is flashing.

e Ifanalarm action has been set, it can be deleted by using DELETE ALARM ACTION.

e The back arrow returns to the Alarms menu.

Alarm Action menu

1

3 4 5 6 7 8
T2l Seld lS 16
19 elseidaee 23 24
2t 28 290 30 31 32

Figure 47- Alarm Action menu page

The Alarm Action menu for each alarm is accessed through that alarm’s Alarm Setup menu. It is used to select an
action that is carried out when the alarm is triggered.

e The top grid of numbers 1-32 is used to select a “go to pre-set position” action.

e The IR action option forces the camera into Mono mode when the alarm is triggered. When the alarm
status is de-asserted the camera will return to the saved colour mode as set by the Camera Setup menu.

e The RELAY option can be used to trigger the auxiliary relay in the junction box when an alarm is raised.

e The bottom grid of numbers 1-16 can be used to select a “start pre-set tour” as the alarm action

e Options M1-M4 can be used to select a “start mimic tour” alarm action.

e The back arrow returns to the Alarm Setup men

This is the property of CBC (Europe) GMBH, no copying without

05/07/2016 permission

46




CBC (EUROPE) GMBH GANZ Nautilus Technical Manual Version 1.0

Alarm Mask menu

ALARM MASK 1 - NOT SET

EDIT ALARM MASK
DELETE ALARM MASK
DELETE ALL ALARM MASKS

Figure 48- Alarm Mask menu page

The Alarm Mask menu for each alarm mask (1-10) allows access to the Alarm Mask Setup menu and the ability to
delete masks.

e To open the Alarm Mask Setup submenu for the selected alarm mask, send a “select” command while
EDIT ALARM MASK is flashing.

e If an alarm mask has been set, it can be deleted by using DELETE ALARM MASK.

e All masks can be delete by using DELETE ALL ALARM MASKS

e The back arrow returns to the Alarms menu.

Alarm Mask Setup menu

ALARM MASK 1
flo TREUNTREE S 08 o

G e
START 00:00 END 00:00
vV 4 L 2

Figure 49- Alarm Mask Setup menu page

The Alarm Mask Setup menu for each alarm mask (1-10) is used to set the days and times when alarms are
disabled.

e To turn the mask on for a given day of the week, select the “-“ dash under the relevant letter. The dash
will turn to an “X” to show the mask is on for those days. “H” stands for holidays, which can be set in the
Alarm Holidays menu.

e The beginning and end time of the mask in hours and minutes can be set using the up and down arrows.

e When a mask is on (i.e. the system time is between the start and end times of a day marked with an “X”)
then all alarms are disabled.

e The back arrow returns to the Alarm Mask menu
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Alarm Holidays menu

HOLIDAY 1 - NOT SET

EDIT HOLIDAY
DELETE HOLIDAY
DELETE ALL HOLIDAY

Figure 50- Alarm Holidays menu page

The Alarm Holidays menu for each alarm holiday (1-10) allows access to the Alarm Holiday Setup menu and the
ability to delete holidays.

e To open the Alarm Holiday Setup submenu for the selected alarm holiday, send a “select” command while
EDIT HOLIDAY is flashing.

e Ifanalarm holiday has been set, it can be deleted by using DELETE HOLIDAY.

e All masks can be delete by using DELETE ALL HOLIDAY.

e The back arrow returns to the Alarms menu.

Alarm Holiday Setup menu

HOLIDAY 1

Figure 51- Alarm Holiday Setup menu page

The Alarm Holiday Setup menu for each alarm mask (1-10) is used to set the dates of holidays, which can be used
to disable alarms on specific days of the year.

e The date of the holiday (in DD/MM format) can be set using the up and down arrows.
e The back arrow returns to the Alarm Holidays menu
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Display menu

INFO DISPLAY OFF
INFO ALIGNMENT LERT
ERROR DISPLAY OFF
LANGUAGE ENGLISH
POS TEXT ALIGN BEFT
SITE NAME SETUP

EDIT DEFAULT POS TEXT
DISPLAY ERROR LIST
DATE AND TIME SETUP

POS OVERRIDES
&

Figure 52 -Display menu page

The Display menu is accessed from the Setup menu and provides control over various options relating to the On
Screen Display and menus, as well as access to the pre-set overrides submenu.

e The INFO DISPLAY option controls whether unit information is displayed on the second OSD row of the
screen when the menus are not active. Options are ON or OFF. Default OFF. Unit information consists of
“CAM 0/<unit id>/<unit protocol><status>" where status is:

0 DIRif the unit is under joystick control
0 Pxif the unit is at a pre-set position, where x is the pre-set number
0 Sy if the unit is performing a pre-set tour and y is the tour number.

e INFO ALIGNMENT sets whether the unit information string controlled by the previous option is LEFT or
RIGHT aligned. Default LEFT.

e ERROR DISPLAY controls whether the system gives notification of internal errors using the on-screen
display if they occur. Can be set to ON or OFF. Default OFF.

e LANGUAGE can be used to select the menu and OSD language from ENGLISH, FRANCAI, DEUTSCH, ITALIAN
or ESPANOL. Default ENGLISH.

e POS TEXT ALIGN sets the alignment of pre-set position text to LEFT or RIGHT. Default LEFT.

e SITE NAME SETUP opens the Site Name Setup submenu, which is used to set and position an on-screen
name for the PTZ unit.

e EDIT DEFAULT POS TEXT opens the Edit Default Position Text submenu, which is used to set default text
which appears before the pre-set position number on-screen when the PTZ unit moves to a pre-set
position. If a pre-set position has position text set separately through the Motion menu, this is displayed
instead of the default.

e DISPLAY ERROR LIST opens the Error List submenu, which can be used to see if the unit has detected any
internal errors.

e POS OVERRIDES opens the Position Overrides submenu which it used to tie specific “go to pre-set
position” commands to special actions.

e The back arrow returns to the Setup menu.

This is the property of CBC (Europe) GMBH, no copying without

05/07/2016 permission

49




CBC (EUROPE) GMBH GANZ Nautilus Technical Manual Version 1.0

Site Name Setup menu

EDIT SITE NAME

ABCDEFGHIJKLMNOPRQRSTUVUWX
YZabcdefaghiJklmnoparstuv
wxyz0123456789

- OFF

Figure 53 - Site Name Setup menu page

The Site Name Setup menu is accessed from the Display menu and provides control over the unit site name which
appears on screen whenever the menus are not active.

e The site name can be set using the on screen keyboard to select characters. The backwards triangle can be
used to delete the previous character, and the forwards triangle is used to confirm the site name.

e DISPLAY MODE controls whether the site name is displayed or not. It can be set to ON or OFF. Default OFF.

e The back arrow returns to the Display menu.

Edit Default Position Text menu

NEW DEFAULT POS TEXT

ABCDEFGHIJKLMNOPGRSTUVUWX
YZabcdefghiiklmnoparstuv
wxyz0123456789

Figure 54 - Edit Default Position Text menu page

The Edit Default Position Text menu is accessed from the Display menu and provides control over a default
position text which is displayed when the PTZ unit is at a pre-set position.

e The desired text can be set using the on screen keyboard to select characters. The backwards triangle can
be used to delete the previous character, and the forwards triangle is used to confirm the text.

e DISPLAY MODE controls whether the site name is displayed or not. It can be set to ON or OFF. Default OFF.

e The back arrow returns to the Display menu.
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Error List
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Figure 55- Error List page

The Error List is accessed from the Display menu and provides information about any internal errors that may have
been detected, and allows the user to clear the stored errors if desired. The Error List consists of 8 pages. The first
page gives information of the first error recorded, the first error recorded since the last system power up, and the
most recent error recorded. The information given is the error code and the time and date of occurrence. Pages 2-
8 give details of each error code. If any errors have been recorded, the total count of those errors is displayed,
along with the time and date of the most recent.

e CLEAR ALL ERRORS can be used to erase the currently recorded errors and empty the error list.
e The forwards and backwards triangles can be used to navigate between error list pages.
e He back arrow returns to the Display menu.

Date and Time Setup menu

DATE FORMAT
TIME FORMAT

Figure 56- Date and Time Setup menu page

The Date and Time Setup menu is accessed from the Display menu and provides control over the display format
and time and date setting.

e DATE FORMAT can be set by sending a “select” command while the existing option is flashing. Options
cycle through OFF, SHORT (dd/mmm), MEDIUM (dd/mmm/yy) and LONG (dd/mmm/yyyy). Default OFF.

e TIME FORMAT can be set by sending a “select” command while the existing option is flashing. Options
cycle through OFF, SHORT (hh:mm) and LONG (hh:mm:ss). Default OFF.

e The up and down arrows can be used to set the date and time as desired.
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e The back arrow returns to the Display menu.

Position Overrides menu
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Figure 57- Position Overrides menu page
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Figure 58 - Position Overrides menu page for an LED lighting unit

The Position Overrides menu is accessed from the Display menu and allows the setting of various actions instead
of go to pre-set position movements. For example, the user could select “90” as the ENTER MENUS override. Then,
if the PTZ unit receives a “Go to pre-set position 90”, instead of moving it will open the menus. This is to allow full
control of the system if a limited functionality keyboard panel is in use. The pre-set number associated with a
given function can be set using the forwards and backwards arrows. Pre-set numbers from 2-99 can be selected.

e The POS OVERRRIDES setting determines whether all position overrides are active. It can be set to ON or
OFF. Default OFF.

e The WIPE function will activate the wiper for approximately 5 seconds (2 complete wipe cycles).

e The WASH function will start the following routine:

1. Go to pre-set X where X is the pre-set override set for the WASH function. If pre-set X is not
set, go to step 3.
2. Wait 2 seconds.
3. Trigger the wash relay in the junction box if enabled via DIP switch S6-4.
4. Wait 2 seconds.
5. Begin wiping.
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6. Wait 5 seconds.
7. De-trigger the wash relay in the junction box if enabled via DIP switch S6-4.
8. Wait 5 seconds.
9. Stop wiping.
e MANUAL LIGHT option appears in the menus for units with the LED illuminator. This will toggle between
the lighting mode being OFF or MANUAL. See the LIGHTING menu description for more information.
e AUTO LIGHT option appears in the menus for illuminator units. This will toggle between the lighting mode
being OFF or AUTO. See the LIGHTING menu description for more information.
e ENTER MENUS will open the menu system using the on screen display, or exit the menus if already active.
This is the same functionality as sending a “menu” message.
e COL/MONO will switch between the currently saved colour mode as set in the Video menu, and MONO
mode.
e RESET OVERRIDES will change each pre-set number back to OFF and turn POS OVERRIDES to OFF.
e The back arrow returns to the Display menu.

Special Settings menu

POWER FAIL ate 1 2J0Y
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Figure 59- Special Settings menu page
The Special Settings menu is accessed from the Setup menu and gives control over various system options.

e The POWER FAIL setting determines what levels of functionality the PTZ unit will recreate if it is power
cycled. When power is lost, the system records what it was doing/where is was positioned. With a P/T/JOY
setting, the PTZ unit will return to a pre-set position, resume a tour, or return to the latest position as
determined by joystick control. With a P/T setting, the PTZ unit will return to a pre-set position or resume
a tour, but will not recreate a joystick position if the unit was last under joystick control. Setting OFF
means the PTZ unit will not automatically perform any power fail action when power is restored. Default
P/T/IOY.

e TIMEOUT TIME controls the amount of idle time that will occur before the timeout action starts (if set).
Can be set from 1-10 seconds, or OFF. Default OFF. The timeout action is set with the Timeout Action
submenu.

e TIMEOUT ACTION provides access to the Timeout Actions submenu.

e RELOAD FACTORY DEFAULTS will erase any saved pre-set positions and tours, and restore all default
system settings. Recommended after the unit has been reprogrammed.
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e RESET HEAD will reboot the system as if it had been power cycled. The motors themselves are not reset
and so will not rehome.

e HOME SERVOS will rehome the motors- the menu will exit, then after a short pause the motors will

rehome.
e The back arrow returns to the Setup menu.

Timeout Action menu
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Figure 60 -Timeout Action menu page

The Timeout Action menu is accessed from the Special Settings menu and allows choice of a pre-set position or
tour as a timeout action, to be carried out automatically if the PTZ unit is idle for the time set by the TIMEOUT
TIME setting in the Special settings menu.

e The top grid of numbers 1-32 is used to select a “go to pre-set position” action.

e The bottom grid of numbers 1-16 can be used to select a “start pre-set tour” as the timeout action
e Options M1-M4 can be used to select a “start mimic tour” timeout action.

e The back arrow returns to the Special Settings menu
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Enter Old Password screen

ENTER OLD PASSWORD
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Figure 61- Enter Old Password page

The Enter Old Password page is accessed by selecting the CHANGE PASSWORD submenu in the Setup menu. To
change the password which allows access to the Setup menu, the user must first re-enter the existing password.

e Tosubmit a password of fewer than 6 characters, select the forwards triangle.
e To erase a character, select the backwards triangle.

e A password is automatically submitted when the 6 character is selected.

e The back arrow returns to the Setup menu.

Enter New Password screen

ENTER NEW PASSWORD

ABCDEFGHIJKLMNOPQRSTUVUWX
YZabcdefahidiklmnoparstuv
wxyz0123456789

Figure 62- Enter New Password page

Once a user successfully enters the old password using the Enter Old Password screen, they can enter the new
desired password using the Enter New Password screen.

e To submit a password of fewer than 6 characters, select the forwards triangle.
e To erase a character, select the backwards triangle.
e The back arrow returns to the Setup menu.
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Lighting menu screen

MODE
INTENSITY
BANK

AUTO OPTION

Figure 63- Lighting menu page

The Lighting menu page is accessed from the Setup menu on units with the LED illuminator. It provides control
over the LED lights.

MODE can be set to OFF, MANUAL or AUTO. In MANUAL mode, the lights are controlled by the INTENSITY
and BANK settings. In AUTO mode, the intensity and bank used will automatically change with camera
zoom level, so that the captured scene is appropriately lit. The AUTO mode is set by the AUTO OPTION
setting. Default OFF.

INTENSITY controls the current delivery to the LEDs when in manual control. Can be set to LOW, MEDIUM,
HIGH and V HIGH. Default LOW.

BANK controls which LED bank is powered in manual control. Can be set to IR1 (infra-red wide angle), IR2
(infra-red medium angle), IR3 (infra-red telephoto), IR4 (unused), WL1 (white light wide angle), WL2
(white light medium angle), WL3 (white light telephoto), WL4 (unused). Default IR1.

AUTO OPTION controls whether auto mode will be active in DAY mode, NIGHT mode, or BOTH. This will
detect whether the camera is currently in the selected mode, and then active the lights and control their
bank and intensity if so. In DAY mode, white lights are used. In NIGHT mode, infra-red lights are used.
Default DAY.

The back arrow returns to the Setup menu.
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Appendix 3. Accessories List

Overview Part No. | Name Purpose Comments
LZ-NDNC18X GANZ Nautilus PTZ Unit - 18X SD, Wiper
LZ-NDNC18X-IR GANZ Nautilus PTZ Unit - 18X SD, Wiper, Adaptive
with LEDs Lights
LZN-NDNC30X GANZ Nautilus PTZ Unit - 30X HD-IP, Wiper
LZN-NDNC30X-IR GANZ Nautilus PTZ Unit - 30X HD-IP, Wiper, Adaptive
with LEDs Lights
LZ-NIJCB Intelligent Junction Box -
with PSU
LZ-NS JCB Standard Junction Box -
with PSU
Universal Wall Bracket Wall fixing
Universal Column Bracket Mounting on top of column
Swan Neck Bracket Mounting on top of
column.
Corner Mount Bracket Fixing to corner of wall.
Mid-Pole Mount Bracket Fixing to outside of a 60mm to 90mm dia. Column
column. range.
LZ-10MUC Umbilical Cable 10 metre Link PTZ Unit to Junction
box
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Appendix 4: Camera Data.

A variety of cameras may be specified. The following shows the leading particulars for those most commonly used.

GANZ Nautilus Technical Manual

Manufacturer’s web sites should be consulted for complete data sheets

Version 1.0

Camera Optical zoom Viewing Angle (H) | Minimum Working | Digital Zoom
Distance
Sony FCB-EX2200P Up to 18x Approx. 48° (W)- 10mm (W) to Up to 12x
2.8°(T) 800mm (T)
Hikvision Up to 30x Approx. 65.1° (W) 10mm (W) to Up to 12x
DS-02ZMN3007 —-2.34°(T) 1500mm (T)
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